
Q.1 What will be the difference in population 3 years ago and 2 years ago of a town whose
current population of 2,50,000 is increasing at a rate of 25% every year?

Ans 1. 31,450

2. 31,250

3. 32,350

4. 32,000

Q.2 Find the smallest number by which 6627 must be multiplied to make it a perfect square.
Ans 1. 4

2. 11

3. 7

4. 3

Q.3 Who administers the oath of office and secrecy to the Union Ministers under Article
75(4) of the Constitution of India?

Ans 1. President of India

2. Prime Minister

3. Vice President

4. Chief Justice of India

Q.4 Two banks, A and B, offered loans at 3.5% and 6% per annum, respectively. Atul
borrowed an amount of ₹5,00,000 from each bank. Find the positive difference between
the amounts of simple interest paid to the two banks by Atul after 4 years.

Ans 1. 50,000

2. 51,000

3. 51,500

4. 49,500

Q.5 In which year was the Pradhan Mantri Awas Yojana (PMAY), a flagship mission aimed at
addressing the urban housing shortage in India, launched?

Ans 1. 2018

2. 2022

3. 2014

4. 2015
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Q.6 If 1 is added to each odd digit and 2 is subtracted from each even digit in the number
7125843, then what will the sum of the highest and lowest digits in the new number thus
formed be?

Ans 1. 6

2. 7

3. 9

4. 8

Q.7 Which of the following numbers is divisible by 64?
Ans 1. 5129

2. 4797

3. 5760

4. 5327

Q.8 Harry ranked 34th from the top and 25th from the bottom in his class. How many
students are there in his class?

Ans 1. 56

2. 59

3. 58

4. 57

Q.9 A shopkeeper buys 20 pens at ₹15 each and another 30 pens at ₹10 each. He mixes all
the pens and sells them at ₹14 each. What is the profit or loss per pen he makes on an
average?

Ans 1. ₹0.50 loss

2. ₹1 profit

3. ₹0.20 loss

4. ₹2 profit

Q.10 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 3 £ & 1 2 © 2 5 $ 9 3 © 9 4 3 % 9 3 # © 6 2 (Right)

How many such symbols are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 2

2. 4

3. 3

4. 1

Q.11 Which of the following is the greatest number that divides 104 and 133 and leaves 8 and
5 as respective remainders?

Ans 1. 42

2. 32

3. 41

4. 40

Q.12 Which city hosted the International Cooperative Alliance (ICA) Global Cooperative
Conference and General Assembly in November 2024?

Ans 1. Bengaluru

2. Hyderabad

3. New Delhi

4. Mumbai
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Q.13 The mode of the observations 3, 6, 5, 7, 8, 4, 3, 3, 2, 5, 3, 6, 4, 8 and 5 is:
Ans 1. 7

2. 5

3. 6

4. 3

Q.14 The shorter side of a rectangle is 18 cm less than the longer side. The numerical value
of its area is equal to 6 times the numerical value of its perimeter. What is the length (in
cm) of its longer side?

Ans 1. 23

2. 21

3. 33

4. 36

Q.15 Find the effective price percentage of the marked price after three consecutive
discounts of 8%, 16% and 3%. (Rounded up to two decimal places.)

Ans 1. 73.29%

2. 74.96%

3. 72.61%

4. 74.13%

Q.16 What should come in place of the question mark (?) in the given series?

5 8 17 44 125 ?
Ans 1. 370

2. 360

3. 358

4. 368

Q.17

Ans 1. 16 hours

2. 28 hours

3. 36 hours

4. 42 hours

Q.18 In a certain code language, ‘DISH’ is coded as ‘4268’ and ‘HUNT’ is coded as ‘3527’.
What is the code for ‘H’ in the given code language?

Ans 1. 2

2. 7

3. 6

4. 3

Q.19 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : WQM :: TNJ : %
Ans 1. # = ZTP, % = QKG

2. # = KUY, % = QKJ

3. # = MKP, % = QPI

4. # = JTP, % = MWR
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Q.20 Which of the following methods is used to create a new folder in Windows 11 OS from
Desktop?

Ans 1. Drag a file to Desktop

2. Press Alt + F4

3. Press Ctrl + N

4. Right-click → Select New → Folder

Q.21 What is the primary benefit of having local self-government institutions like Panchayats
in India?

Ans 1. They solely focus on revenue collection.

2. They replace the entire administrative framework of the State.

3. They provide direct access to national policy-making.

4. They are closest to the people and understand local problems.

Q.22
Ans 1. 64 cm

2. 48 cm

3. 16 cm

4. 24 cm

Q.23 Which provision was introduced in the Constitution of India through the 74th

Amendment Act?
Ans 1. Part X

2. Part IX-A

3. Part IX

4. Part XI

Q.24 Which of the following classical dance forms was performed by 'Maharis' as part of
temple service?

Ans 1. Kathakali

2. Kathak

3. Kuchipudi

4. Odissi

Q.25 A man spends 76% of his monthly salary on the rent of his house. If every month he
also spends ₹627 on his conveyance and ₹3,947 on his grocery and saves the
remaining ₹712, his monthly salary is:

Ans 1. ₹22,111

2. ₹22,025

3. ₹22,119

4. ₹22,023

Q.26 As per April 2025, Reserve Bank of India (RBI) allows flexibility in UPI transaction limits
for in-person merchant payments, ranging from ₹2 lakh to _____. .

Ans 1. ₹6 lakh

2. ₹4 lakh

3. ₹5 lakh

4. ₹3 lakh
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Q.34 Which of the following letter-number clusters will replace the question mark (?) in the
given series to make it logically complete?

EJM 13, FKN 15, GLO 17, HMP 19, ?
Ans 1. JNP 22

2. INQ 21

3. JRN 22

4. IOP 21

Q.35 Which of the following key combinations is primarily used to access the File menu in
most legacy and standard Windows applications?

Ans 1. Alt + Insert

2. Alt + F

3. Alt + Tab

4. Alt + Delete

Q.36 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. TL – BV

2. PH – XR

3. GY – OJ

4. ZR – HB

Q.37 Which sequence of steps correctly initiates a blank presentation in MS PowerPoint 2016
or later?

Ans 1. File → New → Blank Presentation

2. File → Save As → Blank Template

3. View → New Window → Blank

4. Home → Layout → Clear All

Q.38

Ans 1. 

2. 

3. 

4. 

Q.39

Ans
1. 

2. 

3. 

4. 
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Q.40 What will come in the place of the question mark (?) in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

122 ÷ 4 + 65 × 5 − 41 = ?
Ans 1. 516

2. 518

3. 512

4. 522

Q.41 Which of the following physical quantities has the dimension [M L−³]?
Ans 1. Energy

2. Density

3. Pressure

4. Work

Q.42 In MS PowerPoint's Slide Master view, what is the primary benefit of customising the
top-level master slide versus individual layout masters?

Ans 1. The top-level master is only relevant when exporting the presentation to other formats

2. Customising the top-level master ensures consistency of universal elements across all slide layouts

3. Changes to the top-level master overrides all formatting on individual layout masters

4. Individual layout masters cannot be edited unless the top-level master is modified first

Q.43 On the map of India, the Malwa Plateau is located in which direction relative to the
Chotanagpur Plateau?

Ans 1. South

2. West

3. East

4. North

Q.44 Samrath ranked 31st from the top and 13th from the bottom in his class. How many
students are there in his class?

Ans 1. 44

2. 42

3. 41

4. 43

Q.45
Ans 1. 

2. 

3. 

4. 

Q.46 A shopkeeper fixes the marked price of an item 52% above its cost price. What
percentage of discount on the marked price should be allowed to gain 14%?

Ans 1. 28%

2. 22%

3. 27%

4. 25%
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Q.47 Consider the following statements regarding the Indian Navy's initiative of Indian Ocean
Ship (IOS) Sagar in April 2025.
The IOS Sagar initiative involves the deployment of INS Sunayna to the Southwest
Indian Ocean Region (IOR) with a combined crew of India and nine Friendly Foreign
Countries (FFCs).
The FFC personnel would undergo training at various naval professional schools at
Visakhapatnam.
The ship INS Sunayna was planned to be deployed for over a month in April 2025,
undertaking port calls at Dar-es-Salaam, Nacala, Port Louis, Port Victoria and Male.
Which of the above statements are correct?

Ans 1. 1, 2 and 3

2. Only 1 and 3

3. Only 2 and 3

4. Only 1 and 2

Q.48 Umesh sold an article at a loss of 22%. If he had bought the item at 5% less and had
sold it for ₹935 more, then he would have gained 15%. Find the cost price (in ₹) of the
article.

Ans 1. 2,992

2. 2,839

3. 3,488

4. 3,241

Q.49 Who among the following was appointed as the Managing Director of National
Agriculture Cooperative Marketing Federation of India Ltd (NAFED), in October 2024?

Ans 1. Ashok Chandra

2. Deepak Agarwal

3. Vipin Kumar

4. Praveena Rai

Q.50 Which of the following caves are famous for its high citadel?
Ans 1. Junagadh caves

2. Ellora caves

3. Sudama caves

4. Bagh caves

Q.51 In industrial settings, Freon-12 is most commonly manufactured by which chemical
reaction?

Ans 1. Wurtz reaction

2. Swarts reaction

3. Elimination reaction

4. Substitution reaction

Q.52 This question is based on the five, three-digit numbers given below.

(Left) 107 788 634 346 488 (Right)

(Example- 697 – First digit = 6, second digit = 9 and third digit = 7)
(NOTE: All operations to be done from left to right.)

What will be the resultant if the first digit of the highest number is added to the third
digit of the lowest number?

Ans 1. 13

2. 14

3. 17

4. 15
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Q.53

Ans 1. 

2. 

3. 

4. 

Q.54 The Lipulekh Pass, important for India’s border trade, lies between India and
___________.

Ans 1. Bangladesh

2. Afghanistan

3. Bhutan

4. Tibet (China)

Q.55 Mr. Alex starts from Point A and drives 9 km towards the South. He then takes a left
turn, drives 3 km, turns left and drives 19 km. He then takes a left turn and drives 7 km,
turns left drives 5 km. He then takes a right turn and drives 4 km. He takes a final left
turn, drives 5 km and stops at Point P. How far (shortest distance) and towards which
direction should he drive in order to reach Point A again? (All turns are 90 degrees
turns only unless specified)

Ans 1. 8 km to the East

2. 6 km to the West

3. 10 km to the East

4. 4 km to the West

Q.56 As per World Bank’s State of Social Protection Report 2025, between 2010 and 2022,
social protection coverage in low- and middle-income countries increased from 41% to
______.

Ans 1. 51%

2. 47%

3. 45%

4. 43%

Q.57 Dipti, Priti, Neeti, Reeti, Swati, Kirti and Jyoti are sitting around a circular table, facing
the centre. Dipti sits second to the right of Priti. Jyoti sits to the immediate left of Priti.
Swati is an immediate neighbour of both Jyoti and Neeti. Reeti is an immediate
neighbour of Priti. Who sits second to the left of Neeti?

Ans 1. Reeti

2. Jyoti

3. Priti

4. Dipti

Q.58 In a certain code language, ‘DEAF’ is coded as ‘6458’ and ‘FLIP’ is coded as ‘4723’. What
is the code for ‘F’ in the given code language?

Ans 1. 2

2. 7

3. 8

4. 4

Q.59 With whose assistance did Chandragupta Maurya overthrow the Nanda dynasty?
Ans 1. Bimbisara

2. Chanakya

3. Megasthenes

4. Bindusara
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Q.60 A bike can finish a certain journey in 6 hours at the speed of 92 km/hr. In order to cover
the same distance in 3 hours, the speed of the bike (in km/hr) must be increased by
____.

Ans 1. 86

2. 98

3. 92

4. 85

Q.61 What defines a conjoint vascular bundle?
Ans 1. Xylem and phloem present on the same radius

2. Xylem and phloem alternate along the radii

3. Cambium is absent

4. Xylem only on the outer side

Q.62 6 times the present age of Sujatha is 6 years more than 3 times the present age of
Vanita. After 7 years, 4 times the age of Vanita will be 6 years less than 6 times the age
of Sujatha. The age of Vanita is k years more than that of Sujatha. What is the value of
k?

Ans 1. 2

2. 6

3. 7

4. 4

Q.63 A and B complete a work in 6 days. If A alone can do it in 7 days, then B alone can do it
in ______________ days.

Ans 1. 44

2. 42

3. 43

4. 41

Q.64 What is Lord Thomas Babington Macaulay best known for in the context of British
India?

Ans 1. Introducing the Vernacular Press Act

2. Framing the Government of India Act, 1858

3. Drafting the Indian Penal Code and promoting English education

4. Leading the revolt of 1857

Q.65 Eshwar starts from Point Y and drives 13 km towards the south. He then takes a left
turn, drives 27 km, turns right and drives 51 km. He then takes a left turn and drives 18
km. He takes a left turn, drives 35 km. He then turns left, drives 45 km, turns left and
drives 18 km to stop at Point Z. How far (shortest distance) and towards which direction
should he drive in order to reach Point Y again? (All turns are 90-degree turns only
unless specified.)

Ans 1. 47 km towards the north

2. 42 km towards the east

3. 36 km towards the south

4. 51 km towards the west
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Q.66 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) @ * # % * 8 1 4 2 2 & 4 8 9 8 8 # 6 $ $ * 3 (Right)

How many such numbers are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 2

2. 3

3. 1

4. 4

Q.67 In a certain code language, ‘RATS’ is coded as ‘3571’ and ‘TUBE’ is coded as ‘2146’.
What is the code for ‘T’ in the given code language?

Ans 1. 2

2. 1

3. 7

4. 6

Q.68 Which of the following options is INCORRECT regarding the factors that inflamed the
feelings of the Sepoys and led to the Revolt of 1857?

Ans 1. Compulsion on sepoys to wear their caste marks and follow their own caste

2. Forceful conversions to Christianity

3. Act that required every new recruit to give an undertaking to serve overseas

4. Army maintaining chaplains at state cost and promotion of Christian propaganda among the sepoys

Q.69 Which of the following is a tributary of the Yamuna river?
Ans 1. Son

2. Tons

3. Gomti

4. Teesta

Q.70 The mean proportional between 0.09 and 16 is:
Ans 1. 120

2. 12

3. 1.2

4. 0.12

Q.71 The average of 6 numbers is 18. If each number is increased by 5, what will be the new
average?

Ans 1. 20

2. 25

3. 23

4. 18

Q.72 If ‘+’ means ‘subtraction’, ‘−’ means ‘multiplication’, ‘×’ means ‘division’ and ‘÷’ means
‘addition’, then what will come in place of the question mark (?) in the following
equation?

96 × 8 − 11 ÷ 83 + 22 = ?
Ans 1. 204

2. 193

3. 199

4. 186
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Q.73 Which metal was extensively used for coinage in the Mauryan Empire?
Ans 1. Gold

2. Iron

3. Silver

4. Copper

Q.74 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All bears are cats.
All cats are pandas.
Some bears are tigers.

Conclusions:
(I) Some tigers are cats.
(II) Some pandas are bears.

Ans 1. Neither conclusion (I) nor (II) follows

2. Only conclusion (II) follows

3. Only conclusion (I) follows

4. Both conclusions (I) and (II) follow

Q.75 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : ACG :: CEI : %
Ans 1. # = WYC , % = GIK

2. # = WYC , % = KIM

3. # = XYC , % = GIM

4. # = WYC , % = GIM

Q.76 What is the primary purpose of the 'Formula Bar' in MS Excel?
Ans 1. To insert charts and images

2. To change the background color of cells

3. To display and edit the contents of a cell

4. To navigate between worksheets

Q.77 The enactment of the first Cooperative Credit Societies Act in 1904 was influenced by
which of the following?

Ans 1. Simon Commission

2. Indian Famine Commission

3. Royal Commission on Agriculture

4. Hunter Commission

Q.78 Which of the following letter-number clusters will replace the question mark (?) in the
given series to make it logically complete?
LEJ21 MFK32 NGL43 OHM54 ?

Ans 1. PIM65

2. PIN65

3. PIM66

4. PIN66
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Q.79 The Shillong Plateau is divided into several parts. Which of the following is not a part of
it?

Ans 1. Mikir Hills

2. Garo Hills

3. Maikala Range

4. Khasi Hills

Q.80 A boat takes 18 minutes to go 59.4 km upstream. The ratio of the speed of the boat in
still water to that of the stream is 3 : 2. How much total time (in hours) will the boat take
to go 29.3 km upstream and 51.5 km downstream?

Ans 1. 3.5

2. 2.6

3. 4.5

4. 0.2

Q.81 What was the poverty headcount ratio in urban areas in 2019-21, as per the National
Multidimensional Poverty Index 2023?

Ans 1. 19.28%

2. 5.27%

3. 32.59%

4. 8.65%

Q.82 What percentage of the urban population in India lives in slum conditions as per the
Census 2011?

Ans 1. 14.7%

2. 18.2%

3. 12.8%

4. 17.4%

Q.83 The doctrine of judicial review originated in which country?
Ans 1. United States of America

2. India

3. United Kingdom

4. France

Q.84 Which power suffered a decisive defeat in the Malabar region during the Battle of
Colachel in 1741?

Ans 1. English East India Company

2. Spanish East India Company

3. Austrian East India Company

4. Dutch East India Company

Q.85 The larger of two supplementary angles is 60° more than the smaller one. The smaller
angle (in degree) is:

Ans 1. 67°

2. 65°

3. 60°

4. 64°
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Q.86 Seven boxes, A, B, C, D, E, F and G, are kept one above the other but not necessarily in
the same order. D is kept second from the bottom. Only three boxes are kept between D
and E. F is kept in one of the positions below D. Only A is kept between E and G. B is
kept in one of the positions above E. How many boxes are kept between A and B?

Ans 1. 2

2. 1

3. 3

4. 4

Q.87 Find the sum of roots for the equation 2x3 + 7x2 − 9x + 12.
Ans

1. 

2. 

3. 

4. 

Q.88

Ans 1. 48

2. 40

3. 31

4. 39

Q.89 Who among the following has won the Sahitya Akademi Award 2024 in Dogri for his
book 'Ik Hor Ashwthama'?

Ans 1. Velu Aasaan

2. Chaman Arora

3. Madhav Kaushik

4. Vilas Dangre

Q.90 Which Indian state hosted the Khelo India Youth Games in 2025?
Ans 1. Bihar

2. Uttar Pradesh

3. West Bengal

4. Madhya Pradesh

Q.91 What has been the trend in the unemployment rate for individuals aged 15 years and
above from 2017-18 to 2023-24?

Ans 1. Fluctuated between 5% and 6%

2. Remained constant at 6%

3. Increased from 6% to 7%

4. Decreased from 6% to 3.2%
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Q.92 Select the pair that follows the same pattern as that followed by the two pairs given
below. Both pairs follow the same pattern.

LQM : NSN
ETG : GVH

Ans 1. BKL : FJL

2. GHM : KMO

3. WHO : XZQ

4. BRQ : DTR

Q.93 10 is related to 2 following a certain logic. Following the same logic, 45 is related to 9.
To which of the following is 50 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

Ans 1. 10

2. 5

3. 20

4. 15

Q.94

Ans 1. 102

2. 441

3. 561

4. 321

Q.95 What should come in place of the question mark (?) in the given series?

517, 494, 461, ?, 365, 302
Ans 1. 438

2. 418

3. 428

4. 408

Q.96 If 1 is added to each odd digit and 1 is subtracted from each even digit in the number
8731542, what will be the difference between the highest and lowest digits in the
number thus formed?

Ans 1. 6

2. 4

3. 5

4. 7

Q.97 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which is the letter-cluster pair that
DOES NOT belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. PS - OR

2. HK - GJ

3. JH - KL

4. LO - KN
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Q.98 Seven friends, K, L, M, N, O, P and S, are sitting in a row facing north. Only two people
sit to the left of S. Only three people sit between S and O. K sits second to the right of S.
Only two people sit between K and M. L sits at some place to the right of N but at some
place to the left of P. How many people sit to the right of L?

Ans 1. Three

2. Four

3. Two

4. One

Q.99

Ans 1. 

2. 

3. 

4. 

Q.100 A person who spends 55% of his monthly income is able to save ₹6,408 per month. His
monthly expenses (in ₹) are:

Ans 1. 7,832

2. 7,834

3. 7,873

4. 7,843
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